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What we will cover today
Appellate Briefs

e Formatting Rules
e Creating your Appellate Brief template

Law Review Comments & Seminar Papers
e Formatting Rules and Sample Template

e Citation Managers including EndNote, CiteGenie, and
Zotero
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Formatting your Appellate Brief

ONEDOES NQT SIMPLY,

'

WRITE AN APPELLATE BRIEF.
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Follow the Rules

Kano v. National Consumer Co-op Bank, 22 F.3d 899 (9th Cir.

1994).
e The court imposed a $ 1,500 sanction on the appellant’s attorney

e The court found the opening brief violated Rule 32(a); the text was
spaced one-and-one-half lines apart, and the typeface in the footnotes
was much smaller than permitted by the rule, containing eight lines per
inch instead of six.

Varda Inc. v. Ins. Co. of North America, 45 F.3d 634 (2nd Cir. 1995).

e The court denied the winning side $ 1,000 in appellate costs because of
its overlong footnotes (such awards are usually routine).

e The 50-page brief included 58 footnotes, many more than a page long.
It would have totaled 70 pages if presented in standard format.
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Federal vs. State Rules

Federal court of appeals lawyers must consult two sets of rules:
the Federal Rules of Appellate Procedure (FRAP) as well as the
“local rules” of the court to which the appeal is being taken.
e For example, the FRAP sets page limits for reply briefs; but the D.C.
Circuit regulates brief length by the number of words. The Ninth

Circuit requires that parties submit "excerpts of record” rather than
the "joint appendix” more common in other appellate courts.

State appellate courts also usually have detailed rules with
substantial variation from state to state. In California, the
requirements for the format and length of these briefs are found
in the California Rules of Court, rules 8.204 and 8.883



Step 1: Insert
Section
Breaks

Insert two section breaks to create
three sections: the cover page, the
preliminary information section
(e.g. the table of contents and table
of authorities), and the main
argument section.

To insert a section break,
go to the Page Layout tab,
click Breaks, then click
Next Page under the
Section Breaks section
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Page

Mark the point at which one page ends
and the next page begins.

Column

Indicate that the text following the column
break will begin in the next column.

Text Wrapping
Separate text around objects on web
pages, such as caption text from body text.

Section Breaks

HNext Page
Insert a section break and start the new
section on the next page.

Continuous
Insert a section break and start the new
section on the same page.

Even Page
Insert a section break and start the new
section on the next even-numbered page.

0Odd Page

Insert a section break and start the new
section on the next odd-numbered page.

Microsoft Office 2010




Step 2:
Insert
Page
Numbers

The goal for this step is
to insert the page
numbers in the footer of
each Section so that they
number independently.
This is a multi-step
process.

First, go to the Insert tab,
select Footer, and choose
Edit Footer from the
drop down menu.
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In the Header & Footer Tools tab, unselect the option for “Link to Previous” section for
footer sections 2 and 3.

Once you have unselected the link to previous option, the “Same as Previous” language
(highlighted in blue) will disappear.

[ | Different First Page
N Different Odd & Even Pages 431, Footer from Bottom:
' Tex ] Insert Alignment T

Footer -Section 2-

Header -Section 3- ] Facts and argument Same as Previous




From the Insert tab,
first insert your page
number in the desired
position, then select
Format Page Numbers

Page Number Format [ 2 ﬁl

Mumber format: |1, 2, 3, ...

[7] tndude chapter pumber

Chapter starts with style: |Heading 1
|se separator: - (hyphen)
Examples: 1-1, 1-A

Page numbering

) Continue from previous section

-

@ Startat: |1 =

[=]

Ok ] I Cancel

"—

% Hyperlink

|" Bookmark

Cnline

Video Ell_:| Cross-reference
Media Links
- YR R RPN

[ Header - A
D Footer =

Text
[#] Page Mumber - Box~

Comments

B Top of Page

" [E] Bottom of Page
k=] Page Margins
[#] Current Position

Eh Format Page Mumbers...
E;'{ Remove Page Mumbers

Format the numbers in each section to either
Roman (i) or Arabic (1), and make sure that the
page numbering begins at 1 for each section.

Repeat for each section in your paper.
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Format
Headings

First, write out your
headings.

Then, select the text for
your first heading, right-
click Heading 1in the
Styles menu and choose
“Update to Match
Selection.” Repeat for
headings 2 and 3

In this step you will format each h&dlngm the main
argument to your brief specifications. Typically an appellate
brief will utilize three heading levels (e.g. 1., A., and 1.)
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= L| l|qT AaBchDt‘AaBchDc AaBchDc‘AaBchDt AaBbCcl AC]H AaBbCc./|AaBbCcDi | AgBbCcDi | AaBbCcDi| A

| == THormal | Mo Spaci..| Heading Update Heading 1 to Match Selection  5,ptitle  Subtle Em... Emphasis | Intense E..
Y Modify.. i
ragraph I - es
v Select All: (No Data)
N N EosogoooFooong
= Rename...

Remove from Quick Style Gallery

Add Gallery to Quick Access Toalbar

Main Argument
I. Heading One

Bacon jpsum dolor sit amet salami jowl drumstick kevin ham landjaeger frankfurter pork chop sausage
tenderloin. Venison t-bone rump sirloin, ground round chuck frankfurter strip steak bresaola spare ribs

pig meatball tail biltong filet mignon. Venison tri-tip beef ribs cow, sirloin chicken short loin frankfurter
boudin. Strip steak sausage andouille chicken M pastraml corned beefspare ribs porkchop chuck

salami frankfurter ¢

turducken drumstic Need some sample text? Try (boring
spareribs eberkes” gtandard), (passages from famous novels),

(theme songs & catch phrases), or
(BACON?!)


http://www.lipsum.com/
http://www.fillerati.com/
http://tvipsum.com/
http://baconipsum.com/

Step 4.
Write your
Brief!




_Step 5:

Home Insert Page Layout References Mailings Review View
| =f Add Text - .__[;'] Insert Endnote = :ﬂ Manage Sources ] =] Insert Table of Figures
== | ! update Table AE Mext Footnote = | — 1% Style: | APA Fiftt - =1 Update Table
Table of Insert Insert o Insert
Contents ~ Footnote ==| Show Motes Citation = 4 Bibliography - Caption ‘% Cross-reference
Built-In 5 & Bibliography Captions
n
I I f | Automatic Table 1
I a e o Contents
L Heading 1
A Heading 2

1. Heading 3 i

Contents

Automatic Table 2

Go to the References tab, click g e
on Table of Contents, and R, :

select one of the default
choices (you can always

Manual Table

change the style of the TOC Table of Contents. 1
after it is generated). e chaper e et 2 2
vaou have not used Styles for L_Q More Table of Contents from Office.com 4
% . . 2l InsertTable of Contents... Depending on your version

YOUI’ headlngs (eg lfyour F_}\ Eemove Table of Contents

; o - of Word, you may have to
headings were manually )

insert a dot leader. To do

formatted), the Table of : 50 highlight a TOC line
Contents will not generate - right click for paragrap’h
aumm":ti(gilh;_anf YOli will be o formatting, select Tabs,
prompted to first apply : then select the option to
heading styles from the Styles : display a leader
gallery (Step 3). -




p 6:
Create your
Table of

Authorities

Select your first citation and
click on the Mark Citation

button on the References tab.

For each citation, choose the
category (case, statute, etc.)
you want that citation to
appear in, and make the
necessary changes to the
Short Citation beneath.

Once you've marked all your
citations, you can insert your

Table of Authorities from the

References tab.

References

rt Endnote
Footnote -

Motes

Mailings Review View

L 1} Manage Sources

Insert _
Citation - 1} Bibliography -

Citations & Bibli r

il

Insert

2] Insert Table of Figures
|2 update Table

=] Insert Index -

= + i +
2 Update Index

Mark Mark

i Insert Table of Authorities
|2¥ update Table

Caption %] Cross-reference Entry Citation

Table of Authorities

Civil Rights of Institutionalized PersonsActof 19805 3,42 US.C. § 1997a(2000).

(e |

F
Mark Citation

Selected text:

Baker v. General Motors Corp., 522 US. 222, =« Next Citation
228 (1998).
-
Category: |Cases
|E| Mark Al

Short citation:
Cate,
er v. General Motors Corp., 522 1.5, 222, 228 (1998).

-

-

Long dtation:







ormatting Rules

Atnerican
University
Law Review

Prefers submissions wia ExpressO.

Please include an abstract and CV.

EzxpressO or
AULRarticles@gmail.com

ExpressO or
AULRarticles@@ gmail.com

Appaachian
Journal of Law

Submit by e-mail to

law _journal @my . asl.edu or mail to:
Appaachian Journal of Law
F.O. Box 2825
Grundy, Va 24614

The journal prowides a forum for issues
that shape the lives ofthe people and
communities of Appalachia. It includes
issues concerning alternative methods of
dispute rezolution and community
service. Although focused on the
Appaachian region, the usefulness of the
publication will not be limited by
geographical boundaries.

law_journal@my.asl.edu

law_journali@my.ad.edn

Arizona Law

Accepts submissions wia Scholastica or

Strong preference for articles under

Expedite requests may be submitted wia

Scholastica, ExpressO or

Review Expresso (please do not submit through 35,000 words (including footnotes). Scholastica or ExpressO {or e-mail to submisd onsi@arizonalawr ev
bath). Include a rémumé or O, submissionsi@arizonalawreview.org iew.org
If you are unahle to submit via Bluchook ditation format. if you are unable to access ExpressC).
Scholastica or Expresz0, please send it Dioes not review expedited manuscrpts
submission siariz onalawreview.org bhefore article selection begins in March
As of January 20, 2014, their w ehsite ;nd Septemba’. Reqmrgs at least 7 c_iays
: N . ot the time an expedited request iz
saysthey will begin accepting made.
submissionsin February 2014.
Arizona State Exclusively uses Scholastica Text and footnotes should conform to the | Scholastica Scholastica
Law Journal Bluehook and Chicagn Wamal of Style.
Arizona Interested in Arizara Stmmit Law lawreview @AZ SummitLaw.edu lawreview @AZSummitLaw.
Summmit Law Reniew? Feel free to email us at edu
Review lawreview@AZSummitLaw_edu to find

(formerly the
Phoenix Law

out more.

Review)
Arkansas at Submit via e-mail to Requests that all articles be submitted in lawreview @ualr.edu lawr eview @ualr.edu
Little Rock lawreview@ualr.edu triple-spaced format (text and footnotes).

{(University of)
Law Review

Prefers Microsoft Word format, but will
accept in Word Perfect.

Follows the Bluebook and the Texas Law
Review Manual on Usage and Style.

Allen Rostron & Nancy Levi, Information for Submitting Articles to Law Reviews, & Journals,
available at http://papers.ssrn.com/sol3/papers.cfm?abstract_id=1019029




e [cademie Academic legal writing : law review articles,

g oh
g [egal Writing
Reefis &
St

student notes, seminar papers, and getting on
law review / by Eugene Volokh ; with foreword by
Alex Kozinski

Een o '!“
Y e ptia it
B fuurth Hiton

Available in the LRC Reading Room at KF250 .V64 2007

Sample template from the book available


http://www2.law.ucla.edu/volokh/writing/
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Equation Symbol

| -1- =k == L j -A J 4 A= signature Line ~
Cross- zﬁ ni @4 g & J é é = = _‘%Date&ﬁme
SmartArt Chart Screenshot | Hyperlink Bookmark Cross-reference | Header Footer Page Text Quick WordArt Drop .
- > v  Mumber~ | Box~ Parts~ > Cap~ '@ Object ~
R f Header & Footer

strations Symbols

use force against suspected terrorists.!? The Authorization is predicated upon
the September 11, 2001 terror attacks were an armed attack on the United St
response of force on those responsible.!? Thus, international humanitarian law
to determine whether the CIA officers are operating in a situation of armed conj
which legal classification applies to the CIA officers. Customary internationa

law and statutes of thg —=———==50 St S S0 ey brid tribun

International Court of | S, r the Formd

Using the Insert tab, use the International Crig}| roomote [=] [Footote nunber <] |pal Crimin:
h « f I3) Spec]a] CO'urt for Sler [¥] tnsert as hyperlink [ tndude above below he case la‘
t e CFOSS—re erence Court Of Israel Wl]] b Separate numbers with n as t]fle ~L

i For which footnate: . .
regal'd tO the legallty | | 1 Charlie Savage, Secret U.5. Memo Made Legal Case to Kill a Citizen, N.Y. Ti... » peCIﬁC lﬂtil

. . 2 Id. ("The administration has faced a legal challenge and public criticism for t...l 1 L
Slgﬂed aIld.a/Or I'atlﬁed 3 Greg Miller, CIA Digs in as Americans Withdraw from Iraq, Afghanistan, Wa...— lI].CIU.dC any
the CIA’s

4 1S Kills al-Qaeda Suspect in Yemen, USA Today, Mov. 5, 2002, available at ..
targeted k]]]lngS, as . Mi",er tle. el, Drone Warfare and the Law of Armed Conflict, 39 Denv. 1. L. lnwledgeme:
: 15 9 Drew artide; Greg Miller, CIA Secks New Authority to Expand ¥ D

7 7 g Miller, eeks New Autharity to Expand Yemen Draone....
mv 01‘ emeﬂt. 10 htn:s:ff'A"A'Jw.cia.govfabout-ciafb:days -diafindex.html (Jast visited Feb. 8, ..
11 Vogel, supra note , at 107,
12 Cheri Kramer, The Legality of Targeted Drone Attacks as U.S. Policy, 95a... =

feature when making
supra or infra references.

Obllgat] 0ons. Final 1}73 10| | 5 Afsheen John Radsan and Richard Murphy, Measure Twice, Shoot Once: Hi..

& Christopher Drew, Drones are Playing a Growing Role in Afghanistan, N.Y. ...

This way, your references
will automatically
update even if you
change the ordering of
your footnotes later on

’ Insert ]’ Cancel ]

10 https://www.cia.gov/about-cia/todays-cia/index html (last visited Feb. 8, 2012): see also R
1206 (“[T[hey are not part of a military chain of command, do not wear uniforms, and are not
war.”).

11 Vogel, supra note | at 107.

ot Kacsnane Tha T aaalit od Teoaaiad Dacaa dic ol co TTC Dol O Cocio Cloca I 1.4




Citation Generators

* There are many ways to automatically generate Bluebook

citations.
YUNO GIVE ME CORRECT

e Unfortunately there is
no single generator that
gets it right 100% of
the time.




BACKGROUND
Krazoun, a native and citizen of Syria, initially entered the United States on alSil=;

We St I a W e e e e T RReEaE. who petitioned the INS for a relative visa in |

subjected to verbal abuse, harassmen’ ' tiao
withdrew her pending INS pefition. ON€ czye to Melisza's Research

WestlawNext
N eXt a n d In late 1989, Krazoun met Georgia Ball a4 & pote EE e
obtained a restraining order against Ki sther
marriage to Balesteri, Krazoun adjuste  Highlight | inal
2 (@)(1). Had the marriage endured for t ) | anc
LEXI S the INS to adjust Krazoun's immigratior —CPY Wil REEIENCE (Standard) “eid

In January 1993, Balesteri and Krazoun jointly submitted a motion attesting that they

Ad va n c e motion purportedly contained Balesteri's signature, the signature did not appear to 1

Copy Selected Text to Clipb d

WestlaWNeXt,S COpy With .. - Use your browser tools to copy the selected text below and
v Opinion by' CYR paste it into your word processor.
reference and LeXls Opinion nited States on a student visa in 1979. In 1983, he married 3| i
Advance)s co to United States citizel
. p y LeXiS Advance IE:;ZL%'—%?S:;‘E {E‘;"'K)"g;;:g [Krazoun v. Asheroft, 350 F.3d 208, 209, 2003 U.S. App. LEXI
Chpboard bOth aHOW proceedings in order to determine e
upon his September 2001 marriag
users to select text and decision.
. . I
paste it with an
BACKGROUND Options

accompanying citation.

Copy citation as hyperlink

Krazoun, a native and citizen of Include parallel citations

1979. In 1983, he married a Unite
INS for a relative visa in Krazoun
abuse, harassment, and threats | Use your browser tools to copy the text, then click Close,
against Krazoun, and withdrew h

In late 1989, Krazoun met Georgia Balesteri, a United States citizen; the two married in January




EndNote and CiteGenie

EndNote
* A software package used to manage bibliographies and references when writing articles.

Offers Bluebook citation format though the software itself is not law specific.

e Available for from USD ITS.

CiteGenie

e Developed with the legal
practicioner in mind

e (iteGenie is a Firefox plugin that
creates Bluebook citations from
text you copy from Westlaw,
Lexis, and other websites.

* You can download it

Bieber: What the £ did | do?

STORY HIGHLIGHTS

= NEW: Bieber leaves jail an hour
after judge sets bond at 2 500

* "l ain't got no *ing weapons,”
police guote Justin Bieber as
saying

* Chief: He told police he drank,
smoked pot, took prescription
medication before driving

* 5UVs blocked traffic, which
“faciltated an open road” for
two cars to race, police say

Watch "Justin Bieber's Wild Ride" on CNN at 10 p.m. ET on Friday.

(o1 [T) B Justin Bieber was charged with drunken drivingBiiEZyl]

arrest and driving without a valid license after police 55
star street racing early Thursday morning, Miami Beac

"What the = did | do? Why did you stop me?" Bieber
police officer who pulled him over just after 4 am., acc
arrest report.

Bieber, 19, was released from a Miami jail an hour afte

5

Copy

Copy with CiteGenie

Select All

Search Google for "Justin Bieber w..."

View Selection Source

Inspect Element (Q)

brief appearance through a video link before a Miami judge, who set



http://www.sandiego.edu/its/support/software/available-software.php?_focus=2
http://www.citegenie.com/download_stable.html

/otero

Zotero is a free, easy-to-use tool to help you collect, organize, cite, and share
your research sources.

e Zotero quick start guide

Ll |, | S e Yty b bt et SR PRt T AATMASA B A4S AR IS LR IR IR [ R 41 5 A MMM oIk S . St ey g
Allowance Exclusion and the Religious Exemptions of the Indrdual Health Care Mandate and the FICA and

ST E )
2000 to 2005 (58) Self-Employment Taxes [articie]
1900 tn 1999 75) Cardozo Law Review, Vol 33, [ssus 4 (April 201 3), pp. 16331678
Zelineky, Edward A
1aE0fo 12t 0E) 33 Cardozo L Rev. 1632 (2011-2012) 3
187010 19787) @ Yiew Matching Tet Pages | PriniDownlaad Oplisns ]
B & S DB A B #F-| 4 I-| e | = o=
=) B My Library Tite. Craator X z
. Duplicate Teens ~ | Ml Smoke 2nd No Frae - Analyzing tha Potential Effects of the Mantal Health Parity and Addiction Equity .. Maudin :
[ Linfled Tteme %! Ecanceic Fresdams and the Constitutian Fosen Tem Type: Joundl Article ]
&l Yash B Tithe: Funding Health Care with sn Employer
E B Mandate: Efficiency and Equity Concens
.i Bl Rapulstng Managed Care Coverage: A Mew Direction For Haalth-Planning Apariias Modzansk 1 = Author: Pratt, Katherine @ ®|d
= Wil the Supreme Court Ba Fathiful to Tts Cath to Uphold the Corestitution in the Obamacare Case Presser Absbrack: - |
- Articles that were bookmarked volume: 33 petadata of ]
o tags ta dsplay pages: 1= @rticle selected
Date: 19541595
Series:
Series Tithe:
. Series Text:
=
Pl Journal Abbr: St Lous U, L3
=

e Boston University — Tools for Making Bluebook Citations and Keeping

Track of Research



http://www.zotero.org/support/quick_start_guide
http://lawlibraryguides.bu.edu/content.php?pid=210292&sid=1751086
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We're here to help

Reference librarians are here every day and during
weeknights (except during intersession).

Check our website for current hours:

Reference Desk Phone: 619-260-4612
Ref. Desk E-mail: Ircrefer@sandiego.edu


http://www.sandiego.edu/law/lrc/general/hours.php
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